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Introduction to Tosa Skills Framework 

For Tosa Assessment and Certification  
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Tosa® (Test on Software Applications)   

Tosa assessments and certifications determine and validate a candidate’s proficiency and 

skill level in software applications used in a professional environment. Tosa assessments are 

designed to validate the professional Illustrator software skills of individuals (students, 

trainees, employees, or jobseekers) in supporting their employment, professional, or 

academic objectives.  

Tosa assessments employ the Adaptive Testing Methodology, which creates a personalized 

testing experience adapted to a candidate’s skill level for a selected software application. 

The score is based on the Item Response Theory using a 3-parameter logistic model, similar 

to the GMAT scoring method. Adaptive-based testing selects questions that challenge 

candidates to the limit of their knowledge and abilities.  

Tosa Skills Framework Objective 

This Tosa framework provides an overview of the subject areas being assessed during the 

Tosa Assessment and Certification Exams. Tosa validates candidate proficiency in the most 

popular professional Illustrator software programs using a score on a scale from 1-1000 for 

the Certification Assessment, and a score divided into five levels, from “Beginner” to “Expert,” 

for the Diagnostic Assessment.  

The objective of this document is to present an overview of the technical skills associated 

with each of the four main Illustrator domains within each proficiency level. This information 

will also support educators and trainers in tailoring their training program to achieve desired 

proficiency levels.  

Unique Tosa Scoring  

The Tosa assessments and certifications are based on a unique score, divided into five 

levels. 

• ranging from 1 to 1000 for the certification. 

• divided into five levels, from Beginner to Expert, for assessment. 

 

Tosa® levels 
 

Corresponding 
Tosa® score 

Certification status & documents issued 

Expert 876 - 1000 
Certification earned - diploma & Credly 
digital badge issued 

Advanced 726 – 875 
Certification earned - diploma & Credly 
digital badge issued 

Productive 551 – 725 
Certification earned - diploma & Credly 
digital badge issued 

Basic 351 – 550 
Certification failed - certificate of completion 
issued 

Beginner 1 – 350 
Certification failed - certificate of 
completion issued 
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Illustrator domains and subdomains 

Interface, digital workspace 
and fundamentals 

◼ Managing Illustrator workspace environment 
◼ Creating and transforming objects 

◼ Managing typography, justification, and text objects 

Work on objects 
◼ Distorting objects, extracting illustrations 
◼ Managing PDF files 
◼ Using styles, exporting them to libraries 

Specific functions 

◼ Managing RGB and CMYK color types, color charts and 
color guides 

◼ Creating graphs, structuring data 
◼ Formatting  

Production 

◼ Exporting 
◼ Generating resources 
◼ Extracting and exporting parts of artwork 
◼ Managing printing 

About the Illustrator certification 

The Tosa Illustrator certification relies on a database of around 100 questions. It is 

composed of 35 questions and lasts one hour. The algorithm adapts to each answer of the 

candidates to adjust the difficulty level of the questions until they reach the exact definition of 

the candidates’ level by calculating the limit of their skills. 

 

Since the test is adaptive, the series of questions that each candidate gets is unique for each 

test. This uniqueness allows for a more accurate evaluation of the candidate's level. It also 

limits cheating and the memorization of questions on different passages.  

 

Our platform allows individuals to take the certification in class, in an approved testing center, 

or remotely via our integrated asynchronous online proctoring solutions.              

 

Our remote proctoring solutions provide added flexibility for both the administrator and the 

candidate, allowing the certification exam to be taken anywhere, at any time. The candidate 

only needs an internet connection and a computer equipped with a working webcam and 

microphone. 

 

Candidates receive a numeric score out of 1000 points associated to a proficiency level on a 

five-level scale. Candidates who score between 1 and 550 points don't earn the certification. 

They will not receive a diploma but a certificate of completion. Candidates who score 551 

points or above earn the certification. They will receive a diploma by email within five (5) 

business days and are eligible to a Credly digital badge.   
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There is no requirement to be eligible to take the exam, but our recommendations to be well 

prepared on exam day are:  

 

- Take at least one Tosa Illustrator adaptive assessment to estimate your level and get 

familiar with the test format 

- Use free practice tests on our website for training 

- Follow e-learning or training courses (average duration per level is between 10 and 15 

hours per certification so around 150 hours total)  

 

Tosa certification diplomas are valid for three years from the date of issue as skill levels 

evolve or decline over time, depending on the use of the software. New software and 

software versions are released every year, and skills must be updated. We cannot 

legitimately certify a digital skills level for more than three years. Limiting the certification 

validity reinforces the need for life-long learning and professional development.  

Tosa certifications can be retaken when it is expired. Earners willing to improve their score 

and level can also retake the exam at any time. 
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Tosa Sequence for Progressive Skills Development   

Students and professionals can tailor their certification journey with Tosa, demonstrating their 

expertise in ways that align with their unique needs and goals.     

With the Tosa Adobe Illustrator Certification, starting at a productive level, users can 

progress vertically, advancing to advanced and expert levels as their skills grow. This clear 

path encourages continuous improvement and validates each stage of their development. 

Tosa’s structure makes it easy to track progress and showcase evolving expertise.     

With the Tosa Adobe Bundle Certification, users can expand their skill set horizontally 

across Adobe applications, mastering interconnected applications that touch on a broader 

range of competencies. This flexible approach empowers individuals to develop both depth 

and breadth in their skillset, enhancing career prospects and workplace versatility.    

 

 

 

 



   

 

  

 

Level 1 – Beginner User  

Between 1 and 350 points 
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The Beginner Proficiency is set for a score from 1 to 350, which is the lowest Tosa score 

category. Attaining the Beginner score defines little or limited knowledge of the Illustrator 

application, including the application’s basic functions and features, highlighting the inability of 

the candidate to use the application in a professional environment. 

Overview 

Domain Skills Assessed 

Interface, 

Workspace, 

and 

Fundamentals 

 Identifying and adapting the various panels for personal use 

 Identifying basic tools 

 Knowing what Illustrator is used for 

 Creating a document 

Work on Objects 
 Drawing basic objects 

 Applying fill and stroke color to an object 

Specific 

Functions 
 Using the Text tool 

Production 
 Saving the file in AI (native) or .PDF (generic) format 



   

 

  

 

Level 2 – Basic User  

Between 351 and 550 points 
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Interface, Workspace, and Fundamentals 

Interface 

Candidates know how to start Illustrator and know the specific features of the illustrations 

produced with the software. They are familiar with general user interface elements and know 

how to adapt their work environment to their needs by displaying the necessary panels. 

Candidates know how to open a file and modify it, either in Preview mode or Outline mode, 

depending on the specific needs and requirements. They know how to choose the 

appropriate selection tool from the Selection tools (Arrows) available. 

Fundamentals 

The concept of an object is acquired by candidates. They can manage objects and identify 

the selected element of an illustration in the Layer panel to modify it in a simple way. They 

also understand the objects group concept and know how to manipulate their objects simply. 

Work on Objects 

Knowledge of the interface is good enough to make object management more efficient. 

Objects piles are no longer a problem for candidates who know how to identify and 

manipulate them. Plans management is acquired. 

Candidates know how to use the Object-Arrange Menu article to arrange objects further 

forward or backward in an illustration. Candidates can use the text in a non-linear way and 

associate it with various shapes. The use of the Curvature text tool is acquired.  

They can arrange texts on more complex shapes created with predefined tools such as 

Rectangle or Ellipse. They also know how to duplicate, move, and distort objects with the 

corresponding tools and functions in the Object > Transform menu. 

Specific Functions 

As the various text tools are known to candidates, they can also incorporate special 

characters with the Glyphs panel, if necessary. Their object management also includes the 

basics of the Transparency panel's blending modes to start mixing objects colors and 

achieve subtle visual effects. 

Prior to the acquisition of the skills of the Basic level, the candidate will have 

mastered the skills of the Beginner level. 
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Production 

Candidates know the basic constraints related to the different types of work they can produce 

(print/screen) and can therefore identify, set, and modify the different areas of their 

illustration: artboard, bleed, etc. 

Overview 

Domain Skills Assessed 

Interface, 

Workspace, 

and 

Fundamentals 

Interface 
 Customizing a workspace 

 Working in Preview mode or Outline mode 

 Using the right selection tools 

Fundamentals  

 Assigning a fill and stroke color to an object  

 Managing the stroke of objects  

 Grouping objects 

Work on 

Objects 

 Identifying objects on different layers 

 Writing on a shape 

 Duplicating an object in a specific way, other than copy and 

paste 

Specific 

Functions 

 Finding and typing special characters 

 Knowing the most common blending mode 

Production  Identifying the specific areas of the document 



   

 

  

 

Level 3 – Productive User 

Between 551 and 725 points 
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Interface, Workspace, and Fundamentals 

Interface 

Candidates know how to identify all the interface elements available. They know how to 

create a workspace specifically tailored to their needs by including all the necessary panels. 

Fundamentals 

Candidates can create complex objects using more specialized tools. Object creation and 

management is completely mastered, as in object manipulation and the operations that can 

be applied to them, like cutouts. The stacking of objects and the structure of an illustration 

are also fully mastered.  

Candidates' object management skills include creating specific colors. Pattern creation is 

also assimilated.  

Illustration placement and the overall management of illustrations are not a problem for 

candidates regardless of the method used: linked, embedded, or from Cloud library. Flexible 

use of CC Libraries is also part of the candidates' skills. Candidates also know how to 

choose their work units effectively.  

The different methods of text generation and management are mastered. 

Business application: For example, for a communications manager, these skills allow them to 

optimize his workspace and the creative process. They are thus able to adapt their creative 

projects to their needs and to develop their promotional campaigns on different channels. 

Work on Objects 

Objects interactions are known and fluid. Candidates know how to add, subtract, and divide 

their shapes to create new more complex ones just as they know how to manage the 

transparencies of objects. Creating dynamic, complex objects is also part of candidates' 

skills.  

The alignments and precise arrangement of the objects are well-assimilated subjects. The 

identification, creation, and management of masks are also acquired.  

Candidates are aware of the different swatch books available, know how to find them, and 

create the colors adapted to their needs. 

Candidates streamline their production using symbols and text styles in complex illustrations. 

Business application: For example, for a communication manager, these skills allow them to 

rework and edit their own communication supports containing illustrations (brochures, 

Prior to the acquisition of the skills of the Productive level, the candidate will have 
mastered the skills of the Basic level. 
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leaflets, emailings, templates, etc.) as part of the evolution of the company's offer or 

products. 

Specific Functions 

Candidates are familiar with the Image Trace and Live Paint functions. They can also present 

illustrations in several color variants. The creation of very complex gradients, especially with 

the Mesh Tool, is acquired.  

The deformation of objects is known, either in shape blending or in envelope distortion. Work 

on the perspective grid is mastered, especially in its constraints. Importing images for 

template purposes is easily managed by candidates, as is the web preview work and the 

resulting pixel grid constraints.  

Candidates can create and manage symbols that include automatic deformations in the 

graphs they generate. Candidates also know how to create text tables. 

Business application: For example, for a communications manager, these skills allow them to 

optimize the process of creating and updating content for their many marketing materials, 

such as digital ads, flyers, or brochures. 

Production 

Candidates’ knowledge of the various production constraints, related to the different types of 

work, allow them to decide to vectorize text on demand if needed. 

They also know how to package a document to make it stand-alone and send it for 

outsourcing, production, or archiving. 

Font installation principles and constraints are mastered by the candidates on their 

machines. These are specific to an operating system, but the candidates are also able to 

explain the process to any external technical contacts and even know the how-to for other 

operating systems. 

Business application: For example, for a communications manager, these skills allow them to 

import and export common file formats such as PDF, JPEG, PNG and thus be able to share 

their communication materials more easily with all his contacts. 

Overview 

Domain Skills Assessed 

Interface, 

Workspace, 

and 

Fundamentals 

 Managing all interface panels 

 Drawing regular objects using shape or position constraint 

shortcuts 

 Coloring objects with colors and patterns created on demand 
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 Cutting out objects in various ways 

 Changing the stacking of objects 

 Identifying and applying patterns to objects 

 Importing illustrations in various ways  

 Using CC libraries 

 Managing units based on the purpose of the work 

 Accurately identifying text tools 

Work on 

Objects 

 Mixing objects by adding, subtracting, or cutting them and 

creating complex shapes with the achieved results 

 Managing the transparency of objects 

 Using masks 

 Using colors from other swatch books 

 Aligning the different points of the shapes or dynamically 

modifying the shapes with the appropriate functions and then 

aligning or arranging them precisely 

 Creating and using symbols 

 Managing a text with styles 

Specific 

Functions 

 Coloring an illustration with Live Paint 

 Using the Mesh Tool 

 Creating programmed deformations between two shapes 

 Distorting objects with effects or with envelope distortion 

 Using symbols for graphs 

 Working on the perspective grid 

 Using an image as a template or vectorizing it 

 Working with a web-specific preview mode 

 Arranging text in a table 

Production 
 Vectorizing text when necessary 

 Packaging a file to send it to outsource 

 



   

 

  

 

Level 4 - Advanced User 

Between 726 and 875 points 
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* 

Interface, Workspace, and Fundamentals 

Interface 

Candidates have a complete knowledge of Adobe Illustrator's interface. They know how to 

set up their tools and their workspace. 

Object management in the layer panel raises no difficulty for candidates who know how to 

identify and select objects accurately according to their needs. Using the Object article in the 

Selection menu is also an acquired skill for candidates who know how to select hard-to-

select objects. 

Workspace 

Artboard management is fully acquired and used to respond effectively to print or web 

production issues. 

Fundamentals 

Candidates know how to use all the Object Selection Tools available or change Adobe 

Illustrator's functions to access hard-to-select objects. Vector paths and related tools are 

used fluidly. 

Managing the specific colors for web or print illustrations is fluid. They know how to choose 

the color mode when creating or identifying the colors they create. RGB/CMYK conversion 

errors are identified and managed immediately. 

Business application: For example, for an advertising manager, these skills allow them to 

optimize the design process. They are thus able to adapt the creative projects created 

upstream by their teams to the needs of his clients and to develop promotional campaigns on 

different channels. 

Work on Objects 

Gradient tool and panel knowledge is complete. Candidates master the creation and 

application of complex gradients on all object’s components. 

The cutting of objects and their different effects are not a problem for candidates who know, 

at the Advanced level, how to create compositions of dynamically editable objects. The 

duplication and precise arrangement of the objects are managed with ease.  

The concept of drawing inside another object allows candidates to accelerate their 

productions by creating clipping masks faster. 

Prior to the acquisition of the skills of the Advanced level, the candidate will have 

mastered the skills of the Productive level. 
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The texts are managed within the illustration: candidates understand the difference between 

a character style and a paragraph style and know when to use each one. The overall change 

in the texts of an illustration is understood.  

The illustrations produced are structured appropriately, making modifications or variations 

easier and faster. 

Business application: For example, for an advertising manager, these skills allow them to 

easily create and edit the graphic aspect of their advertising campaigns while respecting 

marketing imperatives and technical constraints. 

Specific Functions 

Candidates know how to use the transparency panel and create objects with advanced 

transparency features. They are also able to use these options to obtain specific 

transparency in groups of objects.  

All the options in the color panel that differentiate the colors created by candidates are used 

to produce CMYK and/or spot color illustrations. The use of standard swatch books is fluid.  

Candidates know the different ways to save and share their colors and patterns created in 

their swatch panel via -.ai file, -.ase file, or CC library. They know how to communicate 

information depending on the context.  

Candidates' knowledge of the composition of objects in the Appearance panel is complete. 

They know how to create objects with multiple fills or strokes, as well as effects on specific 

components without difficulty. The management and modification of these complex 

appearances is fluid. Symbols are also part of the mastered functions, they are created and 

used without problems. Candidates know how to identify and then modify these symbols in 

their illustrations.  

Candidates are familiar with the perspective grid. They have integrated the specific 

constraints of the function and know how to set it up. They can draw on it without losing the 

benefit of editability through symbols. They can also integrate text objects into their grids 

while keeping them editable. 

Business application: For example, for an advertising manager, these skills allow them to 

rework and edit the graphic creations of their advertising campaigns themselves and thus 

respond quickly to their clients' requests for modifications. 

Production 

Candidates can produce any type of illustration, Web or print. Specific knowledge for both 

applications is complete. Overprinting, which often must be managed on an individual basis 

in the packaging industry, for example, is a parameter that candidates can use via the 

Attributes panel but also via the Transparency panel blending options.  

Supported colors are also known to candidates: they can plan and manage the printing of 

their work. The export of illustrations in all necessary formats is done smoothly. Candidates 
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have integrated the ins and outs of all the main file formats used in web or print domains and 

therefore immediately know which format is best suited. The use of export interfaces for the 

Web is perfectly handled. 

Business application: For example, on an advertising manager's profile, these skills allow 

them to export, share and present their files to his numerous contacts (clients, art directors, 

layout artists, printers, etc.). 
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Overview 

Domain Skills Assessed 

Interface, 

Workspace, 

and 

Fundamentals 

Interface 
 Mastering the Layers panel 

 Manipulating objects in various ways 

Workspace  
 Handling and modifying Artboards  

Fundamentals   
 Using precise vocabulary on the different parts of a vector path 

 Identifying out of gamut colors corresponding to the nature of 

the work in progress (RGB/CMYK) 

Work on 

Objects 

 Applying multiple types of gradients to different components of 

objects 

 Duplicating/distributing objects with precision 

 Merging/dividing objects  

 Using text styles 

 Changing objects appearance 

Specific 

Functions 

 Using the perspective grid 

 Using symbols effectively 

 Managing the transparency of objects 

 Precisely identifying the colors in the color scheme 

 Using the Aspect panel, generating complex aspects 

 Identifying symbols 

 Drawing inside objects 

Production 

 Mastering the notions of overprinting and color supporting  

 Knowing the specifics of each file format during an export 

 Exporting perfectly sharp illustrations for the web 

 

 



   

 

  

Level 5 – Expert User  

Between 876 and 1000 points 
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Interface, Workspace and Fundamentals 

Interface 

Candidates have an in-depth knowledge of Illustrator's parameters and know how to modify 

and adapt them to the needs of their work. They can easily change work units on-the-fly in an 

illustration. They manage their rulers and measures according to one or more artboards. 

Object creation is smooth and efficient using keyboard shortcuts and drawing tools specific to 

each task: drawing from the center, on-the-fly variation of the number of sides on a polygon 

or the star inset tool. Shortcuts are also used when transforming objects.  

All the object Selection tools are known and used. The various Selection tools previously 

used are now complemented by the Magic Wand tool and Lasso tool which are set up, if 

necessary, via the Magic Wand panel. Using these advanced tools, candidates exploit items 

from the Selection menu to make selections on identical types of objects or select objects 

based on attributes that are assigned to them. For this, full knowledge of the ability to assign 

attributes to an object is necessary and fully integrated. Memorizing its selections in complex 

illustrations allows candidates to navigate freely and easily and find objects or groups of 

objects in illustrations. 

Fundamentals 

Candidates know how to make guides with any object and are no longer limited to orthogonal 

guides only. They manage the guides and all the information Illustrator provides in the View 

menu. Therefore, the knowledge of these different types of information (guides, rulers, linked 

text, document grid, perspective grid, slices, etc.) and their effects (snap to point, snap to 

grid, smart guides, etc.) is thorough.  

Candidates also know how to work in Outline, Preview, or Pixel Preview modes according to 

their needs. The web purpose of an illustration does not raise difficulty for them in managing 

the alignments of objects on the pixel grid, which, they know how to activate if necessary, 

during creation to present perfectly sharp illustrations when displayed on screen.  

Candidates' use of the Gradient panel is fluid. They can identify their different types of 

elements: colors, groups, and themes of colors, as well as gradients and patterns. 

The knowledge of typography is comprehensive enough for candidates to make full use of all 

the advanced features that Adobe Illustrator offers.  

They know precisely in which case to produce Area Type objects or, on the contrary, Point 

Type objects. Candidates not only use all basic functions of the Text menu but also have 

perfect knowledge of justification options. They can use the OpenType functions in the 

OpenType panel. 

Business application: For example, for an art director profile, these skills allow them to 

perfectly set up their workspace and thus optimize their graphic design and creativity.  

At this level, the candidate can train on this software. 
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Work on Objects 

General object handling is fully mastered by the candidates. They can create complex 

objects using tool-specific keyboard shortcuts such as polygon or star. They also know the 

shortcut for drawing objects from the center and for proportion constraints. Deformation of 

objects using specific tools or distributed transformation is easy. The repetition of the 

transformations is also managed thoroughly.  

The use of specific functions for dynamic modification of shapes such as ellipses or rounded 

angles with Properties or Transformation panels is commonly practiced.  

Candidates can immediately identify complex objects such as compound paths or clipping 

masks in the Layers panels. The use of these functions is natural and fluid and their 

manipulation when retrieving illustrations or exploring PDF files for extracting elements is 

effective. The simplification of illustrations when opening PDF files is done with ease.  

Candidates have fully integrated the use of the Appearance panel specifically for text objects. 

These objects, which require special attention in their treatment especially for strokes, are 

perfectly manipulated and the illustrations thus produced contain texts that remain editable 

despite the complex functions that are applied.  

To further speed up, facilitate, and make their work more reliable, candidates use graphic 

styles. They know how to create them easily as well as export them to custom libraries or CC 

libraries. 

Business application: For example, for an art director profile, these skills allow them to 

develop complex visual identities in the form of models (or "rough") that they produce for their 

clients.   

At this level, the candidate can train on this software. 

Specific Functions 

Candidates know, in addition to the proficiency already acquired on the different types of 

colors (RGB/CMYK, coming from another swatch book - global or not, process/spot color), 

on the different swatch books available, and how to make their color choices with the Color 

Guide panel. Skills on rules of color association are acquired. The generation of color 

variants in their illustrations is done easily using the Color Guide panel.  

They also master the use of the Adobe Color Themes panel to search and prepare their color 

harmonies. Creating color is easy, as is registering in CC libraries to eventually share with 

collaborators or customers.  

Candidates, since they know how to use simple patterns from the Productive level, have 

perfected their technique to create repetitive patterns. Using and editing these patterns in an 

illustration is easy. 

Candidates manage the creation of complex objects via the Appearance panel. This panel 

becomes an essential element of illustrations, enabling multiple strokes, multiple 

backgrounds, and multiple effects to be applied to the same object. Identifying the attributes 
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of complex appearance of an object in the Layers panel is easy and candidates can modify 

or duplicate those attributes from one object to another, or from object to group of objects. 

They also easily simplify the aspects if necessary, by expanding them. Object expanding or 

appearance expanding are well-known. 

Isolation Mode is commonly used to edit different components of objects, groups of objects, 

or symbols. Creating graphs of all available types is fluid: candidates know how to structure 

their data – if necessary, with a spreadsheet - to introduce it into the interface of the Graph 

Tools in the order required by the type of graph chosen. Graph modification and coloring with 

the right selection tools are acquired.  

Candidates can also create specific symbols that will be used to enhance their graphs. The 

generation of symbols stretching over particular areas in a programmed way is not a 

problem. The integration and possible replacements of these symbols in the graphs are 

easy. Finally, candidates can use character and paragraph styles to reliably caption graphs. 

Business application: For example, for an art director profile, these skills allow them to 

quickly adapt their graphic creations to respond to requests for modifications from their 

teams or clients. 

At this level, the candidate can train on this software. 

Production 

Candidates thoroughly manage exporting their work in all the available ways. They can 

generate web or print illustrations, pixelated, or vectored without distinction.  

Their technical knowledge of web imperatives is enough for the use of the File Export panel 

to be transparent. Generating the resources needed for all uses (different sizes for 

Responsive Design or different device screens) is mastered. Extracting and exporting 

specific parts of the illustration to generate interfaces is not a problem in the same panel.  

Candidates are aware of the color management system that they will have adjusted 

themselves in Illustrator in the Edit menu. They also know how to apply these same color 

management settings to a complete CC suite through Adobe Bridge.  

Candidates' knowledge of printing is comprehensive enough for the most technical terms 

such as overprinting, supporting colors, or knockout being commonly used with contractors. 

Candidates are familiar with Offset printing, but they also know what constraints other 

printing methods may involve: such as screen printing, which normally does not support any 

overprinting, and as a result requires sometimes deep modifications in the illustrations.  

Candidates also manage their paths and especially their texts when sending their illustrations 

to production, as digital cutting induces other constraints at the production level. Candidates 

thoroughly understand the production method for their work and apply the necessary 

modifications to their illustrations. 

Business application: For example, for an art director profile, these skills allow them to import 

and export common file formats: AI, EPS, GIF, JPEG, and PNG and thus be able to export, 
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share and present their files to his numerous contacts (clients, graphic designers, web 

designers, layout artists, printers, etc.).  

At this level, the candidate can train on this software. 
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Overview 

Domain Skills Assessed 

Interface, 

Workspace, 

and 

Fundamentals 

Interface 

 Drawing complex objects by combining keyboard shortcuts 

 Selecting objects accurately with all existing tools 

Fundamentals 

 Drawing and creating guides with any shape 

 Manipulating swatches 

 Managing typography accurately 

Work on 

Objects 

 Repeating transformations 

 Using widgets for dynamic object transformation  

 Identifying and managing compound paths 

 Using different text tools 

 Assigning outside strokes to text 

 Creating graphic styles 

 Generating new objects directly by manipulating them 

 Making full use of appearances 

Specific 

Functions 

 Using the Color Guide 

 Creating graphs of different types 

 Changing graphs 

 Using symbols to enhance graphs 

 Exporting and sharing swatches 

 Generating patterns 

 Creating and expanding complex objects 

 Managing appearances accurately and duplicating as needed 

 Working in isolation mode for objects, groups of objects, and 

symbols 



Error! Use the Home tab to apply Titre 1 to the text that you want to appear here. 

   

 

Production 

Print 

 Printing a document in spreads and saving predefined print 

settings 

 Using the ink manager 

Automation 

 Knowing paragraph and character styles and spotting style 

overrides in the style panels 

 Setting up cascading styles by using the next style parameter 

 Creating paragraph styles with nested character styles 

 Creating table styles containing nested cell styles 

 Adapting the layout during a document size change 

 Anchoring a frame within a text flow 

 Setting up the table of contents 

 Inserting a text variable 

 Creating object styles 
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